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PREFACE

Over the last 10 years, NESIS has been involved in capacity-building programmes in Africa through
training workshops, developing technical manuals and sharing experiences. At the annual NESIS
meeting, held in March 2001, presentation emerged as a priority area among countries engaged
in capacity building. In response to their concerns, a Technical Working Group (TWG) was
appointed to develop a proposal for increased training opportunities on the presentation of
statistical data. A technical team at the NESIS Regional Centre in Harare is now developing training
material on how to organise, analyse and present statistical data, and on how to communicate this
information among countries.

The following year, a workshop on Statistics, Publications, and Information Systems, held in
Nairobi in February, focused on producing information products and services for consumers and
users of statistics. The NESIS Regional Centre in Harare, under the sponsorship of the Working
Group on Education Statistics of the Association for the Development of Education in Africa
(ADEA), organised the workshop.

During the Nairobi workshop, two sessions on Cyberspace Communication and Website
Development focused on using modern communication tools to enhance interaction among
countries, working groups and the NESIS branches. During the Website Development session,
participants were introduced to website communication and participated in an interactive lab
session. The session covered the following topics:

>  Introduction to Microsoft FrontPage 2000 — a guided tutorial on the use of FrontPage
2000 in which participants learnt the use of various menus and functions of the
programme.

>  Using FrontPage to create a simple website — participants managed to experiment
with the knowledge gained in the first session by creating sample test pages.

The ultimate goal is for countries to be able to link the databases and statistical evaluation reports
being generated from their ministries of education to individual websites, and to network these
websites through the Internet, making information available to all. NESIS will make available a
series of tutorials on its website: http://www.unesco.org/nesis or http://nesis.easynet.fr.

It is against this background that NESIS developed a manual on Website Development and Hosting
as a reference guide for future capacity-building workshops. Additional material coming from
feedback from workshop participants and resource persons will be incorporated in it. In addition,
NESIS has produced a manual on Communicating in Cyberspace.
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THE NESIS PROGRAMME

Initiated in 1991 as a project to develop technical modules, the National Education Statistical
Information Systems (NESIS) programme has become a multi-donor, Africa-wide capacity-
building programme to develop self-sustainable statistical information systems for education
policy needs. NESIS is to play a catalytic role in the development process by bringing together
institutions, agencies and experts in joint ventures and networks as agents of change.

To date, over 47 countries have participated in different NESIS activities. These activities include
diagnostic surveys, formulating national plans, and developing and testing of methods and tools
in priority areas. Team experts from different countries meet regularly in technical workshops to
share experiences. Parallel to the activities at country level, NESIS has compiled and published
generic technical modules based on national experiences.

Facilitated by the NESIS Regional Centre and its branch offices, technical working groups (TWG)
are now conducting capacity-building activities in diverse areas of importance to specific countries
in the respective sub-regions. It has become a comprehensive country policy driven programme,
supported by the participating African countries and directly financed by 11 agencies.
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INTRODUCTION

What Is a Website?

Essentially, 2 website is a way to present oneself online. Your website is a place on the Internet
where anyone in the world can visit whenever they want to find out more about you, ask you
questions, give you feedback, or even buy your products. In a realm where the Internet is thought
of as the world’s biggest trade show, your website would be your booth.

Why Use a Website?

In the past, it was trendy to have a website. Today, however, having a website is a necessity. People
are using the web for everything, from researching schoolwork to buying dinner. It is quick,
convenient, and you never need to leave your desk. Even people who prefer to shop off-line are
researching products on the web. Nowadays when people are trying to find you, the first place they
look is on the web — and if they don’t find you, they will probably find someone else!

Your website can be used for a large number of tasks such as:
Making public announcements

Providing support to your customers

Receiving feedback from your visitors
Sharing/distributing files and images

Selling your products

Y Y V YV VY

Acting as a point of presence.

With a website, you will be able to do these things for people around the world at any time of day
or night. You have the potential to become a household name 10,000 miles away.

How a Website Works

A website is a collection of files that reside on a computer connected to the Internet. When people
visit your site, they are actually contacting the computer that is hosting your site, and that
computer (called a web server) gives the visitors the files they want to see. Most normal computers
do not have the power or the software needed to respond constantly to all the requests made by
all the visitors to a site. Those that have would still require a fast and solid connection to the
Internet to keep up with all the requests. Most people and small companies do not have the
resources to run a web server and instead opt for virtual web hosting.
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The Web

The web represents a particular way of accessing and moving through the Internet. It is based on
hypertext, which allows the user to jump to other places within a document, to other documents,
and to other sites. Unlike traditional Internet access that requires the user to move in a strict
hierarchical/linear fashion, the web lets the user bounce through cyberspace, jumping in at the
beginning, middle, end or anywhere else within a location or document, as long as that particular
location or document is linked.

To use the web, you need a browser. There are two basic kinds: line or text browsers, such as
Lynx®, and graphical browsers, such as Netscape® and Internet Explorer®. Text browsers
let users see the text files of documents mounted on the web; graphical browsers let users see the
text and also access any other kinds of files that might appear, such as photographic files, sound
files, or video files.

Sometimes the browser is referred to as the client and the machine holding the data or
information being accessed is called the server.

The physical appearance of the document and how much of it you can access depends on several
things:

> the kind and version of browser that you have

> the way in which the data within the document was entered (that is, the kind of markup
or modelling language used, and the version or standard of that language)

> the way you have set your preferences
> the hardware and software available on your computer

> permissions and rights (password-protected sections that are accessible only to authorised
visitors).

Hypertext

Websites and pages are joined by the use of hypertext links. These links are embedded in the
source code of the documents offered on the Web and appear to the user as coloured, shaded,
underlined, or otherwise distinguishable items (text, icons, and pictures). Clicking on the coded
item activates the link, causing the user to jump to another part of the document, to hear an audio
file, to view a video or to move to another computer anywhere in the world. These links have to be
built into the document by the creator.

Addresses

To access an Internet site via the web, you need to know the URL, the Uniform Resource
Locator. The URL has standard parts:
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>  aprotocol
>  amachine name
>  a path/file name. (Occasionally, a port may be given as well.)

The protocol indicates the application (telnet, gopher, ftp, nntp, http, etc.) being used to
access the machine (site) and file. URLs that are not persistent undergo frequent changes. The file
you accessed yesterday may be moved today and removed tomorrow. This has a tendency to
frustrate novice users. With a bit more experience you will learn to track down files that have
moved and accept the complete removal of files as “just the way it is on the web”.

Addresses on the web are often case, space and symbol sensitive. You should always
enter them exactly.

Browsers

The browser governs what you can do within a particular site on the web. Many of the graphical
browsers have incorporated a variety of Windows® features such as the ability to select and save
portions of text, save files, print files and electronic mail.

Browsers such as Netscape® and Internet Explorer® let the user set personal preferences. These
personal preferences, especially those relating to colour and font, will have an impact on the
appearance of your document on the user’s machine. Conversely, your personal preferences
should be set to standard when you are using your browser/computer to create web documents or
what you see may not be what anyone gets.

Occasionally, you may go to a website and see absolutely nothing, although your browser tells you
the document loading is complete. The creator may have placed colour and font settings in her
document that are incompatible with your personal preferences — similar to wearing blue in front
of a blue screen. In fact, the document is there and it may highlight and/or print normally.

Remember, the browser only interprets the code to the best of its ability. The closer that code is to
standard, the closer you will come to seeing the coded item in the way in which its creator intended.

Source Code

Web documents consist of displayed content and source code. The most common source codes
used to create web pages include hypertext markup language (html), XML, and Cold Fusion.
Html is a formatting language. It allows the creator to code a document so that a displayed version
of the document will look somewhat like the original — for instance, so that bold type will stand
out. Other kinds of markup language, such as sgml, are meta-languages, which do much more
than simply format the documents. They may allow the content of a document or documents to
be manipulated in various ways, creating, for example, a table of contents, a nominal index, or a
collection of items based on a requested set of criteria. The more you know about markup
language and how it works, the more efficiently and effectively you will be able to move through
the web and access needed materials.
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Realities

Constructing a website, whether for an organisation or for an individual, is a lot like constructing
a house. Your first thoughts should not be of buying the nails, the wood and the tools, or telling
your friends the new address. There are more important things to think about first. What kind of
a house would you like? Is it appropriate to your lifestyle? Can you afford to maintain it? Does it
fit in with the neighbourhood? Are there zoning regulations to consider? Will you need help
building it?

In terms of a website, the questions you should ask yourself are similar.
Before beginning, accept two basic realities:

> Except for pages whose access are restricted through appropriate authentication and
authorisation procedures (such as usernames and passwords), you have no control over
the way in which users will proceed through your website.

> You have no control over the way in which your page will appear in every kind of
application, browser, or computer that may be used to view your site.

If you can truly accept these realities, you will spend far more time on the content, functionality
and usefulness of your site, and far less time worrying about constructing a perfectly designed,
beautiful site.

Contents

> This is probably the single most important decision to make. It has an impact on design,
on links, on content, and even on site maintenance.

> Ifyou are putting up institutional or organisational information, are you the source of that
information? Most institutions and organisations have particular departments or units that
are responsible for the currency and accuracy of particular pieces of information. You
should not usurp their authority by adding your own version to your web page. Instead, you
should link to the authoritative source, after receiving any necessary permissions.

> If you have volumes of text with few or no links, you need to put it on a gopher or ftp site,
or link your site to a database of information. Web-based organisation is non-linear, and
non-hierarchical. Structure of the information should be based on standards and on a
thorough knowledge of how automated robots, wanderers and spiders index web-based
information and sites.

> Just as libraries may have several editions of the same book and indicate in their
catalogues when new items are on order, you may want a spot on your site for
archived materials (older versions of information or older items) and an indication
that future items are expected.

> There is nothing less conducive to return visits than a dead-end site. Self-contained sites
are often nothing more than advertisements or elaborate brochures; once you have seen
them, you don’t bother with them again.
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The homepage and all adjacent pages need to look and feel similar to the user. Consistency
is reassuring and allows the user to scan materials efficiently once they have a feel for the
site’s layout. As well, many users may come to a page on your site without passing through
your homepage. Always, always, always, make sure they can tell immediately where they
are, and where your homepage is. Location, as they say, is everything.

When you build a house, you want tight joints and square corners — it is the same on a
website. Make sure your content is coherent and logical. The most important information
needs to be up front. Who, what, when, where, why, how, and how much will provide a
quick guide for creators and users.

People all over the world can and will access your site. Is what you are saying appropriate
to a global audience, whose first language is not English (have you incorporated a
translation function?), who may not understand cute icons, contractions or slang
expressions? Are your addresses and telephone numbers complete enough for a global
audience? Is the organisation of your information based on standards, or did you simply
organise it in a way you liked? Do you have applets that eat bandwidth and cause the
download time to increase beyond the patience of the average user? W3, the World Wide
Web Consortium, has issued Web Content Accessibility Guidelines 1.0, which discuss some
of these issues and more. The site address is http://www.w3.org/TR/WAI-WEBCONTENT/.

Be discreet. While you might think it is cool to have your picture on a website, you may be
courting trouble. Personal information such as the name and address of your significant
other, your children’s names and ages, your hobbies, etc. is just that — personal. Not
everyone on the Internet is there for legitimate purposes. Stalkers, harassers,
pornographers, and con men will use all the information they can find. Identity theft is
a growing problem.

Remember your users have rights as well. Do not ask for unnecessary personal
information and under no circumstances use such things as bots, intelligent agents, and
cookies to collect and/or disseminate personal information without the users’ informed
consent.

Make sure the important links are the first links the users see. Add a table of contents of
some sort (this might be a navigation bar, a site map, a tab index).
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WEB HOSTING

What Is Web Hosting?

To have a website on the Internet you first need to have a web server. Unfortunately, owning a web
server can be costly and requires technical expertise that most businesses do not have. This is
where web hosts come in. Web hosting companies provide the equipment and other necessary
technical resources without the headaches that come with individual hosting.

A web host is like the landlord of building. A landlord rents out storefronts to various businesses.
The businesses decorates and run their stores differently, and do not worry about the maintenance
of the building. In a similar way, a web host rents out space on a web server (or entire web
servers), to various businesses. Each business builds its own website and never has to worry about
the maintenance of the web server.

In other words, the web host provides the place on the Internet where your website lives. It is a lot
cheaper than buying your own server, and you do not have to hire any technical staff.

Choice of Server

Shared Server

Shared servers offer clients the ability to host their website on a powerful, professionally managed
server, at a low monthly cost. Shared servers provide individual websites with redundant
connectivity, 99 percent uptime and 24/7 monitoring for a fraction of the cost of a dedicated server.

> Intended Clients and Uses — Shared servers are an excellent solution for entry-level
hosting needs. Designed to host small-scale e-commerce sites and static web pages, shared
servers offer first-time webmasters without advanced skills a reliable web presence.

> Server Response Time — The activity of other sites and the number of other sites on the
server can affect shared server performance.

> Flexibility and Scalability — As you are restricted to the server box space, upgrade capacity
is primarily focused on disk size and throughput.

> Software — Shared servers are limited to the software the hosting provider installs.
> No technical skills required to use a shared server.

Shared server hosting provides a cost-effective way for entry-level webmasters to maintain a
reliable web presence without extensive technical resources.

Virtual Private (VPS) Server

Virtual Private Servers (VPS) combine the flexibility of a dedicated server with the economical
prices of shared server hosting. VPS websites reside in private and protected areas on a shared
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server. They maintain an independent set of applications, allowing the client to share the expenses
of hardware and network connections while maintaining a secure allocation of RAM and CPU.

>

Intended Clients and Uses — Virtual Private Servers are intended to meet entry-to-mid-
level hosting needs. The potential functions of a VPS are wide and varied. It can be used as
a simple FrontPage server or as an advanced, database-driven commerce server.

Server Response Time — Virtual environments are not affected by the activity of other sites
on the server, but their allocated resources and bandwidth limit site performance.

Flexibility and Scalability — Upgrade capacity is primarily focused on disk size, number
of processors and throughput.

Software — As you maintain your private section of the server, you are able to incorporate
many software options.

Moderate technical skill level is required — UNIX administration, basic programming,
and database capabilities are needed to operate a VPS.

Virtual Private Servers provide customers with an independent set of web applications to handle
more advanced web-based applications, without the costs associated with a dedicated server.

Dedicated Server

Dedicated servers are a single computer fully devoted to the needs of one customer. They allow for
faster access to information and provide the customer with greater flexibility to add advanced
database and e-commerce applications. As the customer does not share RAM, disk space or a
connection to the router, dedicated servers provide customers with the most advanced web hosting
solutions.

>

Intended Clients and Uses — Dedicated servers are designed for mid-to-advanced-level
hosting needs such as “mission critical” and high-traffic sites. The servers can handle
heavy data-driven sites, advanced e-commerce programmes, video streaming and
multimedia programmes.

Server Response Time — Dedicated server response time depends solely on the volume of
activity on the customer’s website.

Flexibility and Scalability — All aspects of the platform (disk space, memory, etc.) are
upgradeable since dedicated servers are single-client machines.

Software — Unlimited ability to download software programmes to your server.

Advanced technical knowledge is recommended — Experienced programming and
database capabilities.

Dedicated servers provide high levels of security, connectivity and scalability to support high-
volume and mission-critical web-based applications.
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Procedure for Building a Web Presence

Choose a Domain Name for Your Site and Register It

The first thing you need to do when establishing a web presence is decide on a2 Domain Name and
register it. Choosing the right Domain Name is very important, as it directly affects how easy it is
for potential visitors to find your site. Try for something that is easy to recognise, easy to
remember, and to easy to guess. For example, if your business is Children’s Toys then
childrenstoys.com would be a good Domain Name since it is logical, easy to remember, and easy
to spell. It is also a good idea to think of alternate Domain Names in case the first one you think
of is taken.

If you are not planning on building your website right away, you might still want to consider
registering your Domain as soon as possible. Thousands of Domain Names are registered every
day, and there’s no guarantee that yours will still be around when you decide to build your site.
See the section on Domain Naming later in the manual.

Build and Publish Your Website

Building your own website can be gratifying, but does not have to be difficult. Currently, a lot of
software packages are available — such as Microsoft FrontPage 2000 — that make creating and
publishing your website relatively quick and painless. Others include Macromedia Dreamweaver,
HotDog Web Editor, CofeeCup software, Stone Studio, and Adobe Golive.

Promote Your Website

To really succeed on the web, you need more than just a website. You need “traffic” — a steady
stream of visitors coming to check out your products, services, information, and everything else
you offer online. In order to draw people to your site, you need to be listed in the web’s most
popular search engines and web directories. Services like www.netannounce.com can help you get
traffic to your site by listing your site with search engines and giving you tips for making your site
easier to find online.

Analyse the Results

The success of a website is generally measured by how many visitors it gets. Your web server
automatically logs each time someone accesses one of your web pages. Looking at these logs can
tell you how much traffic your site gets, how popular different parts of your site are, and when your
site is the busiest. Analysing your traffic can even give you an idea of which parts of your site may
need to be improved or expanded.

Most web hosting companies have built-in tools such as Urchin that you can use to help you
analyse your traffic. Once you become a customer, it is easy to log into a custom control panel and
access current site statistics.
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E-commerce

E-commerce is the buying and selling of goods and services across the Internet. An e-commerce
site can be as simple as a catalogue page with a phone number. Or, it can range all the way to a
real-time credit card processing site where customers can purchase downloadable goods and
receive them on the spot. E-commerce merchants can range from the small business with a few
items for sale all the way to a large online retailer such as Amazon.com and eBay.com.

Some definitions relating to e-commerce

>

>

Ad Clicks: Number of times that a viewer clicks on an ad banner.

Address Verification: Process used by a credit card processor or other party to verify that
customers’ ordering addresses matches their records.

Automated Clearing House: An ACH transaction is an electronic fund transfer through
the Federal Reserve Bank from a checking or savings account.

Authorisation: The process of checking the validity and available balance of a customer’s
credit card before the transaction can be accepted.

Bandwidth: The amount of information (web pages, text, graphics, video, sound, etc) that
is downloaded through a connection.

Banner: An interactive ad placed on a web page that is linked to an external advertiser’s
website or another internal page within the same website.

“Card Not Present” Merchant Account: An account that allows merchants to process
credit cards without a face-to-face transaction with the purchaser.

Certificate Authority: A Certificate Authority (CA) is a third party who verifies the identity
of merchants and their sites. The certificate authority issues a certificate (also called a
digital certificate or an authentication certificate) to an applicant company, which can then
put the certificate up on its site.

Commerce Server: The server that manages and maintains all transactional and backend
data for a commerce website.

Cross Promotion: The promotion of a website through other traditional forms of
advertising such as magazines, newspapers, radio, TV, billboards, etc.

Delayed Settlement Processing: Once a transaction has been authorised, the merchant
must ship the hard goods before a transaction can be settled. Delayed settlements are
stored online until the merchant selects the transactions for settlement.

Digital Certificate: A Digital Certificate issued by a Certificate Authority certifies that a
merchant and a particular website are connected, just as a photo on your driver’s licence
connects your identity with your personal details. A Digital Certificate verifies to the
shopper that the virtual store is actually associated with a physical address and phone
number, increasing the shopper’s confidence in the authenticity of the merchant.
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Distribution Channel: The method through which a product is sold, including retailers,
cataloguers, Internet commerce websites, etc.

Domain Name: The unique name of an Internet website. For example, yahoo.com is a
Domain Name.

Download: The transfer of information from the Internet to the browsing computer.

Drop Ship: The shipping of a product directly from the manufacturer to the customer
without requiring the retailer to carry inventory.

Electronic Software Distribution: Software that can be purchased and downloaded
directly from the Internet.

Hit: Each time a web server sends a file to a browser, a “hit” is recorded in the server file
logs.

Homepage: The first page through which a viewer usually enters a website.

HTTP: Hyper Text Transfer Protocol is a protocol that allows computers to communicate
with each other.

Keywords: Words that viewers searching for information may use. Keywords can be
purchased from search engine companies so that an appropriate ad banner may be
displayed when a viewer searches for a particular word.

Merchant Account: A “bank account” established with a payment processor for the
settlement of credit card transactions. Any merchant who wants to take credit card orders
must establish a merchant account. Internet merchants need a “Card Not Present
Merchant Account.”

Off-line Transaction Processing: Capture of order and credit card information for later
authorisation and transaction processing through a traditional card swipe terminal or
through a computer.

Order Confirmation: An email message notifying a customer that an order has been
received and will be processed.

Order Management System: A system that accepts orders and initiates a process that
results in the outbound shipment of a finished good.

Real Time Credit Card Processing: Online authorisation of a credit card number in real
time, informing the merchant that the card has been approved.

Settlement: Once the goods have been shipped to the customer, the merchant can key a
transaction for settlement at which time the customer’s credit card is charged for the
transaction and the proceeds are deposited into the merchant account.

SSL: Secure Socket Layer is an encryption technology on the server that scrambles
important data such as credit card numbers and order information when it is being stored
or passed from one computer to another.
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> Shipping Confirmation: An email message notifying a customer that an order has been
shipped.

> URL: Uniform Resource Locator describes the “address” for a document on the Internet.

Companies that provide free web hosting services include:

1. Yahoo! Geocities
2. Free Servers.com
3. Webnax.com
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WEB DESIGN

> Make sure your pages are not crowded with so many bells and whistles that your users
cannot find what they want. White space is important and you should use it
effectively.

> Each page on your site should be functional (just as the kitchen in your house is designed
for cooking, the dining room is designed for dining, etc.).

> Many people do not have fast connections to the Internet. Graphics take forever to load.
Many serious researchers shut off the image-display function to speed up load times and
avoid the distraction of advertisements and other extraneous information. If you have to
use graphics, make them minimal and/or provide a text path.

> Blinking text, running footers, and tinny music may be popular with designers; they are
not popular with serious web users.

> As noted, this is the web — you are supposed to be making hypertext connections, not
linear and hierarchical connections.

> Ifyou designed your page for Netscape 4.5® on a high resolution monitor using a specific
web editor that may be the only configuration in which it looks good. Try checking your
page in several different browsers such as Internet Explorer 5® and on several levels of
computers before mounting it. You may be surprised at how it appears.

Standards and Guidelines

If you want to have your page mounted on a server, you will have to follow the standards and
guidelines laid down by the server’s owner. The owner of the web server shares legal liability for
the content mounted.

Intellectual property, as it relates to the ownership of materials mounted on the server, permission
for certain links to be made, third party ownership of technology/applications used for document
creation, etc. are matters of valid concern for server owner, website creator and website
maintainer. Once mounted, your page is available worldwide.

If you have violated someone’s intellectual property rights, he or she will find out about it. Every
document, design, file and the like has an owner. You must not mount anything on your page that
is owned by someone else without written permission. Further, you must not indicate you are
the property owner if| in fact, you are not.

Generally speaking:

> All documents should be coded to the accepted markup standard.
> All documents/pages should provide a link to the site homepage.
> The URL should appear within every document/page.
>

All documents/pages should carry accurate creation and revision dates.
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> If you must have large graphics, you must provide estimated times of download.

> Any required viewers, plug-ins, applications, and other utility tools should be noted, and,
if possible, links should be provided to allow users to download needed programmes.

Maintenance

Maintenance is where the real cost of a website surfaces. The cost is hidden in the
amount of time it takes to answer questions, check links, rebuild old pages and build
new ones.

Every page should have a mailto: and/or some other form of email contact for the creator and/or
maintainer of the page/site.

> Mail should be read and answered at least every two to three days (more often if your page
is an institutional or organisational homepage).

Links to other sites should be checked frequently to determine if the URLS are still active and the
sites are still useful.

> Especially pages that are heavily used.
Pages should be updated/revised/altered on a regular basis.

URL-naming structure should be based on standards and on a thorough knowledge of how
automated robots, wanderers and spiders index websites.

Anatomy of a Web Page

Before you start thinking about coding a web page, try to place yourself in the proper mindset.
First, you are creating something that will be, potentially, available to anyone in the world with
access to the Internet and a browser. Second, you are writing for a non-traditional media; your
page should not look and act like a book or a pamphlet. You may want similar information on your
page, but you will have to re-create that information for a global web environment. Third, you will
have to maintain your page. Unlike a book, a web page is never finished and is always
under construction. As new documents appear and disappear on the web, your page should
change. As new standards develop, your page should change. As new technologies appear, your
page should change.

In its most basic form, a web page is created in plain ASCII text using any standard text editor, and
saved as an html file, which can be opened and interpreted by a web browser. How the page looks,
operates, is indexed and interacts with the client will depend in part on how you code the page —
so coding is important. All pages should be coded to accepted standards and the policies of your
institution, organisation or Internet service provider. Checking with your webmaster before you
start may save you time and energy later.
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Tags and Attributes

Tags are designed to tell the computer how to interpret the document you created for viewing by
a human reader. Html is a formatting language and the tags are its tools. There are dozens of
different tags, and html writers must be careful not to use tags that are browser or
platform specific.

In addition, the tags may be affected by the defaults set on your computer when you create the
document and on the client computer when the user views the document.

The format of your text is not governed by the codes generated through keyboard commands. In
other words, hitting return will not necessarily space lines in an html document. All
formatting must be done with standard tags that are understood by the client’s browser.

Most tags come in pairs to indicate the beginning of the format and the end of the
format. For example, <p> indicates the commencement of a paragraph and </p> closes the
paragraph. Many people are careless with the end tags and may not include them. This is not a
good habit to develop for a couple of reasons. First, browsers are designed to work with standard
code. Although some browsers are more forgiving than others, remember, you do not know what
browser your potential users may have and you would like that page to work as you expect it to.
Second, a newer form of markup language, XML, is currently making great strides in the web
world and gaining in popularity. XML requires that tags opened must be closed.

Various attributes (size, shape, position etc.) can be used with some tags to further enhance or
clarify the format.

Among the types of tags that will help you are:

> character tags, which alter the appearance of the characters found between them and, in
the case of header tags, may have an impact on how the document is indexed by
automated indexers

> divider tags, which help you divide portions of your text or portions of your page into
paragraphs, by adding a single line between lines of text, or by using horizontal rules as
spacers

> alignment tags, which align the text between them; for example, centering it on a page

> list tags, which come in various kinds, allow you to indent, provide numbered lists and
bulleted lists.

Perhaps most important of all are the linking or anchor tags that allow your client to make the
hypertext jumps the web is known for.
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Basic Layout

You begin a document by entering the html element. Your document is placed between two tags -
that tell the server to interpret that document as hypertext. i

<html> </html>
The head element contains descriptive information about the document.

<head> </head>

=

Between the head tags, there should be <title> </title> title tags. Title tags are extremely
important to the proper indexing of your page by automated web indexers; you should choose the
text they enclose with care. The information to be “served” to clients should be contained within
body tags — one following the head information and the other probably immediately preceding the
close html tag at the bottom of your document. <body> </body>

Thus, the basic layout of an html file is:

<html> o
<head> é

<title>Title of the document </title >

</head> -
<body> : r :

<p>Displayed title of the document</p>
<p>The content and information</p>

</body> Tlﬂ

</html> '

Applications Integrating Desktop Publishing Functionality

Below are some applications used for web design without using html directly — what you create is :'g
what will be seen on a web browser (the html is automatically generated in the background). Using
the html view, however, you can edit parts of the site by modifying, adding, or deleting the code as

appropriate.

1. Microsoft FrontPage E
2. Macromedia DreamWeaver -

3. Adobe Golive

4. HotDog Web Editors

5. CofeeCup software

6. Stone Studio
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Ten Good Deeds in Web Design

1.

10.

Place your name and logo on every page and make the logo a link to the homepage
(except on the homepage itself, where the logo should not be a link: never have a link that
points right back to the current page).

Provide search if the site has more than 100 pages.

Write straightforward and simple headlines and page titles that clearly explain what the
page is about and that will make sense when read out of context in a search engine results
listing.

Structure the page to facilitate scanning and help users ignore large chunks of the page
in a single glance: for example, use grouping and subheadings to break a long list into
several smaller units.

Instead of cramming everything about a product or topic into a single, infinite page, use
hypertext to structure the content space into a starting page that provides an overview
and several secondary pages that each focus on a specific topic. The goal is to allow users
to avoid wasting time on those subtopics that do not concern them.

Use product photos, but avoid cluttered and bloated product family pages with many
photos. Instead have a small photo on each of the individual product pages and link the
photo to one, or more, larger ones that show as much detail as users need. This varies
depending on type of product. Some products may even need zoomable or rotatable
photos, but reserve all such advanced features for the secondary pages. The primary
product page must be fast and should be limited to a thumbnail shot.

Use relevance-enhanced image reduction when preparing small photos and images:
instead of simply resizing the original image to a tiny and unreadable thumbnail, zoom in
on the most relevant detail and use a combination of cropping and resizing.

Use link titles to provide users with a preview of where each link will take them, before
they have clicked on it.

Ensure that all-important pages are accessible for users with disabilities, especially
blind users.

Do the same as everybody else: if most big websites do something in a certain way, then
follow along since users will expect things to work the same on your site. Remember
Jakob’s Law of the Web User Experience: users spend most of their time on other sites,
so that’s where they form their expectations for how the web works.

Finally, always test your design with real users as a reality check. People do things in odd and
unexpected ways, so even the most carefully planned project will learn from usability testing.
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Other Points to Consider

1. Using Frames

Splitting a page into frames may be confusing for users since frames break the fundamental
user model of the web page. The user cannot bookmark the current page and return to it (the
bookmark points to another version of the frameset), URLs stop working and printouts become
difficult.

2. Cutting-Edge Technology

Exercise caution on the use of the latest web technology. You may attract a few nerds, but
mainstream users will care more about useful content and your ability to offer good
customer service. Using the latest and greatest before it is even out of beta is a sure way to
discourage users: if their system crashes while visiting your site, you can bet that many of them
will not be back. Unless you are in the business of selling Internet products or services,
it is better to wait until some experience has been gained with respect to the
appropriate ways of using new techniques. When desktop publishing was young, people put
20 fonts in their documents: let’s avoid similar design bloat on the web.

3. Scrolling Text, Marquees, and Constantly Running Animations

Minimise the inclusion of page elements that move incessantly. Moving images have an
overpowering effect on the human peripheral vision. A web page should not emulate a well-
decorated Christmas tree in its constant attack on the human senses: give your user some peace
and quiet to actually read the text! Avoid <BLINK> tag.

4. Complex URLs

Even though machine-level addressing like the URL should never have been exposed in the user
interface, it is there and we have found that users actually try to decode the URLs of pages to infer
the structure of websites. Users do this because of the horrifying lack of support for navigation and
sense of location in current web browsers. Thus, a URL should contain human-readable
directory and file names that reflect the nature of the information space.

Also, users sometimes need to type in a URL, so try to minimise the risk of typos by using short
names with all lower-case characters and no special characters (many people don’t know how
to typea ~).

5. Orphan Pages

Make sure that all pages include a clear indication of what website they belong to since users may
access pages directly without coming in through your homepage. For the same reason, every page
should have a link up to your homepage as well as some indication of where they fit within the
structure of your information space.
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6. Long Scrolling Pages

Although users are willing to scroll beyond the information that is visible on the screen when a
page comes up, all critical content and navigation options should be on the top part of the page.
Also, punctuate your long page with back-to-top links, at appropriate points. Where possible,
minimise the length of your pages to ease readability.

7. Lack of Navigation Support

Don’t assume that users know as much about your site as you do. They always have difficulty
finding information, so they need support in the form of a strong sense of structure and place.
Start your design with a good understanding of the structure of the information space and
communicate this structure explicitly to the user. Provide a site map and let users know where
they are and where they can go. Also, you will need a good search feature since even the best
navigation support will never be enough.

8. Non-Standard Link Colours

Links to pages that have not been seen by the user are blue; links to previously seen pages are
purple or red. Unless absolutely necessary, retain these colours since the ability to understand
what links have been followed is one of the few navigational aides that is standard in most web
browsers. Consistency is key to teaching users what the link colours mean.

9. Outdated Information

Budget to hire 2 web gardener as part of your team. You need somebody to root out the weeds and
replant the flowers as the website changes. Most people would rather spend their time creating
new content than on maintenance. In practice, maintenance is a cheap way of enhancing the
content on your website since many old pages keep their relevance and should be linked into the
new pages. Of course, some pages are better off being removed completely from the server after
their expiration date.

10. Overly Long Download Times Caused by Complex Graphics

Traditional human-factors guidelines indicate 10 seconds as the maximum response time before
users lose interest. On the web, users have been trained to endure so much suffering that it may
be acceptable to increase this limit to 15 seconds for a few pages.

Even websites with high-end users need to consider download times: it has been found that
many users access websites from home computers in the evening because they are too busy to
surf the web during working hours. Bandwidth is getting worse, not better, as the Internet adds
users faster than the infrastructure can keep up.

11. Temporarily Disabling the Use of the Back Button

The Back button is the lifeline of the web user and the second-most used navigation feature (after
hypertext links). Users happily know that they can try anything on the web and a/ways be saved
by a click or two on Back to return them to familiar territory.
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Except for those sites that break Back by:

> opening a new browser window (some users assume these are pop-up advertisements
and close the window before anything is displayed)

> using an immediate redirect: every time the user clicks Back, the browser returns to a
page that bounces the user forward to the undesired location

> preventing caching such that the Back navigation requires a fresh trip to the server; all
hypertext navigation should be sub-second and this goes double for backtracking

12. Opening New Browser Windows

Minimise the number of New Windows on your site. Those visitors to your site who will require
new windows most of the time will open them. Designers open new browser windows on the
theory that it keeps users on their site. The strategy may be self-defeating, however, since it
disables the Back button, which is the normal way users return to previous sites. Users often don’t
notice that a new window has opened, especially if they are using a small monitor where the
windows are maximised to fill up the screen. So a user who tries to return to the origin will be
confused by a greyed-out Back button.

Consistency is one of the most powerful usability principles: when things always behave the
same, users do not have to worry about what will happen. Instead, they £now what will happen,
based on earlier experience. Every time you release an apple over Sir Isaac Newton, it will drop on
his head. That’s good.

The more users’ expectations prove right, the more they will feel in control of the system and the
more they will like it. And the more the system dashes users’ expectations, the more they will feel
insecure.

Interaction consistency is an additional reason for not opening new browser windows: the
standard result of clicking a link is that the destination page replaces the origination page in the
same browser window. Anything else is a violation of the users’ expectations and makes them feel
insecure in their mastery of the web.

13. Lack of Biographies

Web studies have shown that users want to know the people behind information on the web. In
particular, biographies and photographs of the authors help make the web a less impersonal place
and increase trust. Personality and point-of-view often win over anonymous bits coming over the wire.

Sites with by-lines often forget the link to the author’s biography and a way for the user to find
other articles by the same author. Instead, a by-line is made into a mailto: link as opposed to a
link to the author’s biography. Two reasons:

> it is much more common for a reader to want to know more about an author (including
finding the writer’s other articles) than it is for the reader to want to contact the author —
sure, contact info is often a good part of the biography, but it should not be the primary
or only piece of data about the author
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> it breaks the conventions of the web when clicking on blue underlined text spawns an
email message instead of activating a hypertext link to a new page.

14. Lack of Archives

0ld information is often good information and can be useful to readers. Even when new
information is more valuable than old information, there is almost always some value to the old
stuff, and it is very cheap to keep it online. Estimates show that having archives may add about
10% to the cost of running a site but increase its usefulness by about 50%.

15. Moving Pages to New URLs

Anytime a page moves, you break any incoming links from other sites. Avoid hurting the people
who send you free customer referrals by clear notification of the new URL and, where possible,
incorporate an automatic redirect at the old site.

16. Headlines that Make No Sense Out of Context

Headlines and other micro-content must be written differently for the web than for old media: they
are actionable items that should help users navigate.

Headlines are often removed from the context of the full page and used in tables of content (e.g.,
homepages or category pages) and in search engine results. In either case, the writing needs to be
very plain and meet two goals:

> tell users what is at the other end of the link with no guesswork required

> protect users from following the link if they would not be interested in the destination page
(so no teasers — they may work once or twice to drive up traffic, but in the long run they
will make users abandon the site and reduce its credibility)

17. Jumping at the Latest Internet Buzzword

Although it is a good idea (depending on the site’s mission and objectives) to have community,
chat, free email, 3D sitemaps, auctions etc, these are by no means magic bullets. Most Internet
buzzwords have some substance and might bring small benefits to those few websites that can use
them appropriately. Most of the time however, implementing the latest buzzword may hurt most
websites. The opportunity cost is high from focusing attention on a fad instead of spending the
time, money, and management bandwidth on improving basic customer service and usability.

18. Slow Server Response Times

Slow response times are the worst offender against web usability: in a survey evaluating how many
companies are able to attain “the 10-second response time”, major sites had an 84% violation
score. Bloated graphic design was the original offender in response time. Some sites still have too
many graphics or too big graphics; or they use applets where plain or Dynamic HTML would have
done the trick.
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The growth in web-based applications, e-commerce, and personalisation often means that each
page view must be computed on the fly. As a result, the experienced delay in loading the page
is determined not simply by the download delay (bad as it is) but also by the server performance.
Sometimes building a page also involves connections to back-end mainframes or database servers,
slowing down the process even further. Users do not care why response times are slow. All they
know is that the site does not offer good service: slow response times often translate directly into
a reduced level of trust and they always cause a loss of traffic as users take their business
elsewhere. So invest in a fast server and get a performance expert to review your system
architecture and code quality to optimise response times.

19. Anything that Looks Like Advertising

Selective attention is very powerful, and web users have learned to stop paying attention to any ads
that get in the way of their goal-driven navigation.

Unfortunately, users also ignore legitimate design elements that look like prevalent forms of
advertising. After all, when you ignore something, you don’t study it in detail to find out what it is.
Therefore, it is best to avoid any designs that look like advertisements.

20. Prioritise: Good Content Bubbles to the Top

If everything is equally prominent, then nothing is prominent. It is the job of the designer to
advise the users and guide them to the most important or most promising choices (while
ensuring their freedom to go anywhere they please).

On today’s web, the most common mistake is to make everything too prominent: over-use of
colours, animation, blinking, and graphics. Every element of the page screams, “look at me”
(while all the other design elements scream “no, look at me”). When everything is
emphasised, nothing is emphasised.

But it’s just as bad to make everything equally bland.
Here are some ways of using prioritisation to guide users:

> Editorially select the most important stories or items. Give them bigger headlines or
more prominent placement — an old principle that newspapers have used for more than
100 years.

> Use sales statistics to discover the best-selling products and place them on top of search
listings. By definition, most customers will be looking for the best-sellers. It is user-hostile
to bury them in a search listing that is organised by some impenetrable information
retrieval algorithm (or worse: sorted by SKU numbers or other internal attributes that
don’t matter to users).

> Use server traffic to track areas of the site that are seeing unusually strong activity and
place links to these areas on the homepage. Not only will you save users clicks, you will
also make people aware of the current buzz.
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> Use reputation management to predict who will write the best contributions. If
somebody was highly rated in the past, then their new material deserves featured
placement.

> Simply highlight the most popular items in a list that is sorted by another criterion.

> On slowly changing pages, mark new items with a little “new” glyph. This is not necessary
on pages that change all the time (say, newspaper homepages) since the assumption is that
most items will be new on such pages.

There are two main types of prioritisation:

1. In lists of items, make sure the ones the user is most likely to want come out on top or
stand out.
2. Content that is deep within the site sometimes needs to be brought out and featured at

higher levels to make users understand what’s new or hot.

The goal is to give users more of what they need. And easier access to what they need. This is
not always the same as giving people what they want.
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Five Criteria for Evaluating Web Pages

Evaluation of Web Documents

How to Interpret the Basics

1. Accuracy of Web Documents
> Who wrote the page and can you
contact the writer?
> What is the purpose of the document
and why was it produced?
> Is this person qualified to write this

Accuracy
> Make sure author provides email or a
contact address/phone number
> Know the distinction between author
and webmaster

document?
2. Authority of Web Documents Authority
> Who published the document and is it > What credentials are listed for the
separate from the webmaster? author(s)?
> Check the domain of the document, > Where is the document published?
what institution publishes this Check URL domain
document?
> Does the publisher list his or her
qualifications?
3. Objectivity of Web Documents Objectivity

> What goals/objectives does this page
meet?

> How detailed is the information?

> What opinions (if any) are expressed

> Determine if page is a mask for
advertising; if so information might
be biased

> View any web page as you would an

by the author? infomercial on television. Ask
yourself why was this written and for
whom?
4. Currency of Web Documents Currency
> When was it produced? >~ How many dead links are on the
> When was it updated? page?
> How up-to-date are the links (if any)? ~ Are the links current or updated
regularly?
> Is the information on the page
outdated?
5. Coverage of the Web Documents Coverage

> Are the links (if any) evaluated and do
they complement the documents'
theme?

> Isitallimages or a balance of text and
images?

> s the information presented cited
correctly?

> If page requires special software to
view the information, how much are
you missing if you don't have the
software?

> Is it free or is there a fee to obtain the
information? Is there an option for
text only, or frames, or a suggested
browser for better viewing?
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Evaluation of Web Documents How to Interpret the Basics
_"E Putting it all together
: > Accuracy. Ensure that your page lists the author and institution that published the page

and provides a way of contacting them.
> Authority. Ensure that your page lists the author's credentials; the domain is preferred
(-edu, .gov, .org, or .net).
> Objectivity. Ensure that your page provides accurate information with limited advertising
and is objective in presenting the information.

> Currency. Ensure that your page is current and updated regularly (as stated on the page)
and the links (if any) are also up to date.

| '_ / > Coverage. Ensure that you can view the information properly — not limited to fees,
kel browser technology, or software requirement.
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What Is a Domain Name?

Your Domain Name is your address on the web. Just as people use your phone number to call you
on the phone, your Domain Name allows people to access your site on the web. Clever, simple, or
easy to remember Domain Names are most desirable as they can play a large part in attracting
visitors to your site. Most Domain Names end with “.com” (such as microsoft.com), but other
extensions such as “.net” and “.org” are also available. In addition, Domains can be used with
your email accounts, allowing you to send and receive email with addresses such as
“support@yourcompany.com”

Internet Domain Namespace

The root (the topmost level) of the Internet domain namespace is managed by an Internet name
registration authority, which delegates administrative responsibility for portions of the domain
namespace to organisations that connect to the Internet.

Beneath the root DNS domain lie the top-level domains that are assigned by organisation and by
country, and are managed by the Internet name registration authority. These domain names follow
the International Standards Organization (ISO) 3166. Each organisation is assigned authority for
a portion of the domain namespace and is responsible for administering, subdividing, and naming
the DNS domains and computers within that portion of the namespace.

Subdividing is an important concept in DNS. Creating subdivisions of the domain namespace and
private TCP/IP network DNS domains supports new growth on the Internet and the ability to
continually expand name and administrative groupings. Generally, subdivisions are based on
departmental or geographic divisions. There are three types of top-level domains:

>  Organisational domains. These are named by using a 3-character code that indicates
the primary function or activity of the organisations contained within the DNS domain.

> Geographical domains. These are named by using the 2-character country/region codes
established by the International Standards Organization (ISO) 3166.

>  Reverse domains. This is a special domain, named in-addr.arpa, that is used for IP
address-to-name mappings (referred to as reverse lookup). There is also a special
domain, named IP6.INT, used for IP version 6 reverse lookups. For information, see RFC
1886.

Abbreviations are reserved for use by organisations and by countries. The most commonly used
top-level DNS name components for organisations and countries are described in the table below:
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Top-Level Name Component of the Domain Naming System (DNS) Hierarchy

Top-Level
Name
Component

.com

.edu

.gov

int

.net

.0rg

.mil

XX (6.9 .zw,
.3, .Sz, .ke, .ca
etc.)

Description of Organisation Type

An Internet name authority delegates portions of the
domain namespace under this level to commercial
organisations, such as the Microsoft Corporation.
microsoft.com

An Internet name authority delegates portions of this
domain namespace to educational organisations,
such as the Massachusetts Institute of Technology
(MIT).

An Internet name authority delegates portions of this
domain namespace to governmental organisations,
such as the White House in Washington, D.C.

An Internet name authority delegates portions of this
domain namespace to international organisations,
such as the North Atlantic Treaty Organization (NATO).

An Internet name authority delegates portions of this
domain namespace to networking organisations, such
as the National Science Foundation (NSF).

An Internet name authority delegates portions of this
domain namespace to non-commercial organisations,
such as the Center for Networked Information
Discovery and Retrieval (CNIDR).

An Internet name authority delegates portions of this
domain namespace to military operations, such as the
Defence Date Network (DDN).

An Internet name authority delegates portions of this
domain namespace to individual countries. For
example, .zw is the top-level domain for Zimbabwe.

Example of Domain
Name

microsoft.com

mit.edu

whitehouse.gov

nato.int

nsf.net

cnidr.org

ddn.mil

C0.zZW

Beneath the top-level domains, an Internet name authority delegates domains to organisations
that connect to the Internet. The organisations to which an Internet name authority delegates a
portion of the domain namespace are then responsible for naming the computers and network
devices within their assigned domain and its subdivisions e.g. www.africaonline.co.zw,
www.nation.co.ke, www.mweb.co.za, www.sitesofafrica.8m.net, www.microsoft.com.

o
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Examples of Domain Names

The naming system on which DNS is based is a hierarchical and logical tree structure called the - .
domain namespace. Domain names consist of individual labels separated by dots. For example:
mydomain.microsoft.com.

A Fully Qualified Domain Name (FQDN) uniquely identifies the host’s position within the DNS
hierarchical tree by specifying a list of names separated by dots on the path from the referenced
host to the root. The following figure shows an example of a DNS tree with a host called mydomain m
within the microsoft.com. domain. The FQDN for the host would be mydomain.microsoft.com.

"«" (Boat) szth;.n
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= - g | |
%, LT Domains f= -
T}  Second-Lovel
Internat Domans -
=~ managed by r
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Source: Microsoft Corporation.

Note: In general, FQDNs have naming restrictions that allow only the use of characters a-z, A-Z,
0-9, and the dash or minus sign (-). The use of the period (.) is allowed only between domain ‘_ .
name labels (for example, “microsoft.com”) or at the end of 2 FQDN. Domain names are not b

case-sensitive. ik

, . H biw
The figure at the right shows part of the Intarnat aiharty
Internet domain namespace, from the .
root domain and top-level Internet DNS . [Roat) —_.rg,'
domains, to the fictional DNS domain
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Top-leval Intemat m
Crormaina

named reskit.com that contains a host
(computer) named Mfgserver.

Computers and DNS domains are
named based on their position in the
domain tree. For example, because

o . MEpsarver
reskit is a subdomain of the .com ¥
domain, the domain name for reskit is — T,
Fr 4 L N
reskit.com. Damain LI
Source: Microsoft Corporation ST
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TUTORIAL

Website Development Using Microsoft FrontPage 2000

Website Development Using Microsoft FrontPage 2000

The World Wide Web (www) enables millions of people to communicate with each other
throughout the globe. While conversations occur between and among people through Internet
email and Internet newsgroups, individuals or groups can also publish websites — a collection of
single or multiple pages on which information can be shared, statically or interactively.

This tutorial introduces you to web page creation, an aspect that shows you how easy it is to build
a website using Microsoft FrontPage 2000. You will create a “testweb” site that provides information
about Cyberspace Communication. Its pages will contain information on Online Communication,
Netiquette, Online Learning (eLearning), Discussion Boards, and the NESIS Partners.

The best way of learning how to use Microsoft FrontPage 2000 is through hands-on practice. You
will learn how to:

Start Microsoft FrontPage

Create and edit web pages and folders

Insert and format tables, rows, columns and cells
Work with text and hyperlinks

Insert pictures

Position objects

Y V.V YV Y VY

Save your work

The contents for the web pages you will prepare, which will consist of text and pictures, are
available on the NESIS website at http://nesis.easynet.fr or http://www.unesco.org/nesis.

Initial Preparation Tasks

1. You must have Microsoft FrontPage 2000 and Internet Explorer 4.0 or later installed on the
computer you want to use for this exercise. It is assumed that the computer you are using
meets the minimum system requirements for FrontPage 2000 (if you have the full version
of Microsoft Office 2000 installed, then FrontPage 2000 and Internet Explorer 5.0 are
already installed). For more information in case you are not sure, please visit the FrontPage
homepage at http://www.microsoft.com/frontpage.

2. You can use more than one web browser — if you already have another type of web browser
installed on your computer, you can still safely install Microsoft Internet Explorer. When
designing web pages, you will find that it is actually beneficial to test your work in more
than one type of web browser, before you publish your website.

Copyright© NESIS 2002
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30

9.
10.

Note:

The screen examples (also called screen dumps) in this tutorial assume that you have a
standard monitor set to a screen resolution of 800x600, at the minimum. If you are using
a different resolution or monitor, the pages you create during the tutorial may look slightly
different on your screen.

The tutorial also assumes that you are working in a Windows 95 or Windows 98 operating
system environment. If you are using Windows NT, 2000, or XP you may notice minor
differences in the user interface and the locations where files are stored. For example, the
“My Documents” folder in Windows 95/98 is called “Personal” in Windows NT/2000/XP.
These differences do not affect the functionality of FrontPage nor do they prevent you from
successfully completing the tasks in this tutorial.

Use an Internet connection to access the NESIS website (http://nesis.easynet.fr or
http://www.unesco.org/nesis).

Click on the link relating to the “Nairobi Statistical Workshop”.
Scroll down to the section on “Website development user files”.

Download the documents IMAGES.ZIP and PAGES.ZIP. Once you will have created your empty
web containing, among others, the Images and Pages folders, unzip and transfer the
unzipped files to these respective folders, BEFORE YOU BEGIN CREATING YOUR WEB PAGES.

Close the NESIS website and, if applicable, disconnect your Internet connection.

You are now ready to begin the tutorial.

If you have neither WinZip (for zipping and unzipping files) nor Acrobat Reader (for reading
portable data files or pdf files), evaluation copies can be obtained from http://www.winzip.com
and http://www.adobe.com respectively.

To learn more about FrontPage, you may click on the help button =« which identifies key
features and their associated keywords for online Help system and the Answer Wizard in
FrontPage.

[ Bciset remras e ________________________B=i]
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Srberis | v vtz | i | Rty
O irragrr Kinks
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Ervpaing P orapaib iy
- BrayIrg ieba

|*

B W Puiehing s Winlcamie to Help
ek S
sy S oursd in Frortfegs v L reiirn Heplp - bpre v
e Pz i gt SR Beiaciied

[ e ]

- Lomireg Franifage weith Cffcn v Dhpciiy Bad psven 0 pEaTE
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Tasks

A.  Starting Microsoft FrontPage and Creating a New Website

1. To start Microsoft Front Page, on the Windows taskbar click the Start button, point to
Programs and then click Microsoft FrontPage.

[l [, A R T

FrontPage opens and displays a blank page (new_page 1) ready for editing. FrontPage 2000 ot ¥
has a new, integrated interface that allows the creation and editing of web pages and managing . .
entire websites — all within one application. All toolbars and menus are consistent with
Microsoft Office applications and can be fully customised. Convenient keyboard shortcuts also
can be used to accelerate common tasks such as opening webs and pages, printing and many

other commands. ‘B ]

mﬂi Menu Bar
TR =10 W L Standard Toolbar
st i B EEE EEEE]E g Formating Toolbar

B S Close Page =
File Name Title Bar ¥ 1
Views Bar
Progress Indicator
T—7 Scroll Bars

Page View Bar

. AL,
et W, P 1 IJ ! - "l
=[] il L1l
—\ Ty
Status Bar Estimated Download Time
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The Standard and Formatting toolbars provide easy access to the commands you will use most
often when working with FrontPage; they are displayed by default.

The icons on the Views Bar provide different ways of looking at the information on your page or
in your web page. You will notice in the upcoming tutorials that as you work with FrontPage, you
will frequently switch between views to match the current task at hand — from the early steps of
page creation to the web publishing stage.

When you start FrontPage, Page view is displayed by default. Page view is a powerful editing tool for
creating and designing web pages. As you enter text, place pictures, insert documents, create
tables, make lists and design the overall appearance of your web pages, Page view displays them
as they will appear in a Web browser. All the html code is automatically created in the background
and, in future tutorials, we shall show you how to manually edit your html code so as to change
the appearance of your page.

2. Close the “new_page 1" window that appears by default.
(Rt e NUH

Py Dol P el e [k g P ke
SRR e T T Lol T - Ik S
Thpes v B X W EEE EE R SR

For this tutorial, you will create a website with seven pages (including the homepage).
Until it is published for the first time, a website is a work in progress. Unlike printed letters,
memos, and word-processing documents, websites can be dynamically changed or updated even
after they have been published. You can add, delete, and modify text, pictures and entire pages at
any time.

3. Create a new website: File > New > Web.
e [ - |

Pis DS Pem fmed Ppesl Jmic lgie e Bk e

Eﬁu—.-..

4. Select Empty Web. Rename your web as <drive >:\My Documents\My Webs\testweb
(<drive> shall be either C or D or E, depending on which drive you are using). Click

OK.
‘i ek |
8| & 8] &y =
el R R [ ET—— Uigimars
e F vt el et b Sipa e o o o o h repes sk
n;] ﬂ u;l 1' | i T s pmrer ey e -.-h_ﬂ
[ (S TU S s Pravnavond bl Errwen wiak :: : . y
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B.  Creating and Saving the Homepage

The homepage is the front door to your website. Greeting your visitors and providing some
information about the content or subject matter of your site will spark interest in people looking
at your site. It also contains links to other pages in a web.

5. Click on the New Page icon on the left.

EST=TS
[

le]= ]

0. Save the created page: File > Save As > (type index next to Filename).

2 testwet: | e 8B Tk

g e P i 11 hangs. .. I
o [ —
Cancel

Bt an g I“-,L.u.,-. 3

7. Click Change button to change the Page title from New Page 1 to Welcome to the
NESIS site! Then click OK.

Fage i
I#-.-:r- o the MESTE. we
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8. Click the Save button.

w | C.  Creating and Saving the Rest of the Pages of the “testweb” Site
— By
i 10.  Create and save the following six web pages using the steps in B above:
B R
€
t& k) onlinecommunication Online Communication
netiquette Core Rules of Cyberspace
elearning Online Learning

boards Bulletin Boards

partners NESIS Partnership

r% exercise Tasks in Website Development
Ul
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D. Performing Housekeeping

Create a folder called Pages.

Fm-ur-r--—nm--—lw-r-

11.  On the View menu, point to and click Folder List to see the list of folders and web files
on the left column (or click the folder list icon).

,‘|
='r
1

Tt b e e
|U-|#-HH|E|I#M:? }.ﬂ.f'-’ e 'I':l'.! m-l I

| : = =|mrp|EEEEEFE| LA

12.  Using your mouse, drag each of the six saved pages above (except index.htm) into the
Pages folder.

el Ll ]

-5 H-IIEllﬂ'l? L LRk 1L Sk - "|m||
I = = p|EE S EEFE S A
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E.  Developing the Page Contents

ﬂj 13. On the Table menu, point to Insert, and then click Table to create an outline table.

14.  Specify the following in the Insert Table window: 1 row, 1 column, 1 border thickness, 0
cell padding, 0 cell spacing, specify width, 680 pixels.

— 15.  Click OK.

36 Copyright© NESIS 2002
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16.  Create a second table inside the first table: 7 rows, 2 columns, 0 border thickness, 0

cell padding, 0 cell spacing, specify width, 100 percent. E
- .
e B e et Sy kD P el e FETETRY :
Lr@#-EC @a? - BT o.n-ETOT R DOY O
[seres et b v s BU Y EEE EE®®E Sof
.................................. . AT
'l Lk
T
T

17.  Drag the dividing column line to the left, so that the inside table is approximately divided
in a ratio of 1-to-5. Select the first 2 cells of the first column, and use Table > Merge

cells to combine the two cells into a single cell. /ﬁ
L 4 "

e g 0000 FEETERY)
mecrs OO W DS T -
FENE L NCIEE I Y W

|

B b e et i s Tk P i |

D-F-HRESAT ERBT w-o - WO & (8 T 5. ; 1
i B el ] s T B IR ERE EE®® 240 "E-:
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18.

19.

il 20.

o 21.

Use the same method to merge the third cells in both columns, and the fourth cells
in both columns, as shown below:

B Ll e bk Fpma Jack Nl Foase e i |
D-g-HRa0aas «- tRad - HOAD R D6 T 0.
Pom bt s e s B FERE EERE S840

Inserting the NESIS logo: Place the mouse cursor on the first (merged) cell on the
top left corner of the table. On the Insert menu, point to Picture, and then click From
File.

[ p e et Poms Took T P e oo
[Degied I =g n-nc | HOQe e v E.
I!n—\.d -1 m" m-ll:'.-EE'* l"'"-l

I | O pe—

- . oW

=] &l 1 o] [l

| aecd loge
swinskge J o=
anowbd !lrs—uﬂbﬂlwﬂ
elfsiogn 0 speaia
e !'u'ﬂmnm
E_ [nuu:_h:q:l | oK I

Pt ol lyper | Pictusess " i " " peg.” v, " v 5] Carcel Ls

Click OK to insert the logo into the index.htm page (your homepage).
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22.  Select and reduce the logo proportionally to fit into the original column size. Your page
should now look like this:
b bl e et G ek gl Sy (i e
D-gF-HAE2&a47 - "BT - HODE D0 7/ 0.
[rnd ]l bl s 0 B BEW EEEE S
[ T EI

oD
L

23.  On the top cell of the second column, type “Cyberspace Communication”. Select this

title, centre it, change the font type to Verdana and the font style to Heading 1. E
DB m@a® 1had o HOQDS 0¥ O, \
e T = Humd = .Ill.IIIEE'l" l"".ﬂ."--l

3

l!li"ﬁq‘:“r Cyberspace Communication g
[ ]

MR

Al L e,
1
24.  Type “A product from” (press Shift + Enter key), “The NESIS Technical Working f4 )
Group on Website Development”. Select the typed text: change font type to Verdana, il
font colour to red, font style to Heading 5, and centre it.
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ﬂ . W et from

25.  Right-click the third row and select Cell Properties.

- 26.  From the Cell Properties dialogue box, change the cell Background colour to black.

40 Copyright©® NESIS 2002
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A jiFrnthacT Frdin
I S ESE Fivsdon i’ vl i T o HOET BT Dl et

_!Iliiéb Cyberspace Communication

With the cursor on the third cell, change the font type to Verdana, font size to 2 (10 pt),
font colour to white, select bold, centre, activate Caps Lock, and type: NESIS

REGIONAL OFFICE — HARARE, ZIMBABWE | NESIS COUNTRY OFFICE — DAKAR,
SENEGAL.

[, Mvmsah | o oge b Do g bbb _______________________________WOH
B L e bued fwms Tk Taker D sk e

D-@-HAE&aT - BT o HOGE 00 70
.|

Varsd W Bedern e (RS D Bz EE®RESLL

=
I |

N

g mbind Amen
Thar RERIY Facbnica! Wonking Group on ed 5% Deswhprnand

!If;‘é” Cyberspace Communication
I
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Place the cursor in the fourth row. Obtain the text from the downloaded and unzipped file
pages.doc under the title “Introduction”; and paste it on the fourth row. Select the pasted
text (if it is still not selected) and ensure the font type is Verdana, and the font size is 2

(10 pt). Also use Format > Paragraph to put a value of 3 both in Spacing: Before and
Spacing: After.

42

30.

Place the cursor at the end of the first line, in the last paragraph as shown. Then use Insert
> Picture > From file.

C'yrhersplce Communication
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31.  In the Image folder, select image002.gif.

fa i

32.  Click OK to insert picture. ‘el
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33.

34.

Select the inserted picture. In the Alignment list, click-right (or click on the icon) and
then click OK.

lq ﬁ"  Cyberspace Communication
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Reduce slightly the picture and position it in such a manner that it is in line with the text
in the last paragraph, as shown below:

[ E’”" Cyberspace Communication
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35.  Save your work at this point (although all the graphics are currently in the image folder,
if at any point during saving you are prompted to change the folder for images, ensure that
all the pictures are saved under the images folder as shown below — otherwise ignore all

graphics below, related to this point).

o
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36.
37.

Click OK.

Right-click on the cell to the left of the one containing the main text (as shown), and select
Cell Properties.
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38.  Under Vertical alignment select Top.

&

,"'l.;.__;.l-']
39.  Select Maroon as the background colour. \e% Lo

e 8

)
A
Fre

q
40.  Click OK.
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inside the maroon cell, create a table of 1 row, 1 column, 0 border
rest of the values to their default.
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- 41.  With the cursor still
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Right-click the new table and change its background colour to white.
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Insert a Hover Button with no text on it: Insert > Component > Hover Button.
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44.  Delete the default text appearing under Button text; change the width to 96, and the
g height to 10. Leave other values to their default.

Horemi Helcen Pregpaitms

Bysontet | Bt |

Link s | Promse |
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S s ST
AT wan  [E Hesght -

oy o] oo |

=l 45.  Click OK. Type the following text below the Hover Button, as shown: Introduction,
| . Netiquette, eLearning, Boards, Partners, Exercises. Then place a copy of the upper
’ Hover Button at the end of the last text.
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46.  Select this new text plus the Hover Buttons, centre it, and ensure font is Verdana, size 2
(10 pt). Go to Format > Paragraph and make value changes as shown below:

s P gl P g P man By
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= e

T B T e R ]
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47.  Click OK. o
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48.  Select the last cells of both columns. Use Table > Properties > Cell.
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50.  With your cursor inside the bottom left cell, use Format > Font. Select Verdana,
Regular, 2 (10 pt). Open the Color tab and click on More Colors.

51.  Select the grey color shown below (Hex value: CCCCCC).
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52.

53.

Click OK. Then type Copyright NESIS.

j=l=

u"l'.';El' A prodiuct from
T TETE Tecifusiedl Woriby Crpags o Wab BV Deewiopmaesd
L SESI SIS ALOFICE . BARSEE FIMBABWRY | €514 [(We-THE (FPHE . DATAE SESEGaL |

Iqlﬁ"*"“ Cyberspace Communication
1

Ty gors Off T e HE 5 00 301 &F 85 ST Df el Oor0Enn s of Wb Sine
I | e sicpreent 0 tera of crestion, poblictng, dovoen nareng, snd hoatng
IO T
T B N pAmCilY, ek il b s o Mo CONpORInga s Fmar PagE SO0 gincE i
L mming o aesdy nlegraied ko the Ofbice 3000 pechage. Fnpas thal you haws tha bl
- e galt Offea JO00 el dled o g Cormsuter Balire £ omrelrees) e e
d | Dbl il BF O ST yOes S0 G o B IR 1D OTR i AT J AT R
wab wis usrs Froni Pegs =

Fariress
LT e

I § §ywiher erboncemenis and sddnions of Hems and s ionaines: wil be
ncorperaied i fuiures buiossle. 1 m thue enperairss thad you pess or
DaChup eitd Tadhs Soelal Sulrfarlpsd™d Tulivvik sl 8ol Lidel 1hal
Fulie® Deen paricrresd

jzl
[ Mowmad [HTEL  Frrien 41 I

With the cursor on the bottom cell of the second column, follow the same procedure as 37
and 38 above. In addition, right-justify the text. Use Insert > Date and Time.
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54.  Select the appropriate Date and Time formats as shown below:

Date amd Time Propesties

(™ Dhae T psgs vt last sclind
% Dl page was las sutonabeally updated

Diate jomak  [Maich 05 2002 =

Tretms TR - |
[ ] caa |

55.  Click OK to insert the automatic page-update information. This information will
automatically change each time a page is updated. Place the cursor at the start of the date
and time component, press the space bar twice, then add the following: Last updated on:
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56.  To modify the Date and Time properties at any time, right-click on the information and
select “Date and Time Properties”, as shown below. This will take you back to the
window on 41.
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F.  Linking Web Pages

| . 57.  On the navigation column on the left, select Introduction. Use Insert > Hyperlink (or
\ use the hyperlink icon).
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T 58. On the Create Hyperlink dialogue box, under the Pages folder, select
[ ] onlinecommunication.htm.
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Click OK to create the first hyperlink to the introduction page — the Introduction hyperlink
now appears blue and underlined.
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Select Netiquette and link it to netiquette.htm.
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Click OK.
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62.  Now link the four remaining navigation titles to their respective web pages.
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Previewing the Page in FrontPage and in a Web Browser

To preview your page within FrontPage (so as to see how it will appear when using a web
browser like Internet Explorer or Netscape), click on Preview — found at the bottom of the
page, next to Normal and html tabs.
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To use a web browser, use File > Preview in Browser.
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05.  Select the default settings in the Preview in Browser popup window. If you are using
E more than one browser, then select one of them.

‘e I
o Delmd T BDgiD C E0aE0 T LA

(I~ PR o e

06.  Click the Preview tab. The message below appears since Automatically save page is not

. é checked.

Whacinanlt FiondPage
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67.  Click Yes to view the Homepage in a browser. This is how your homepage will be displayed

‘]H . to any public visitor using a web browser.
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68.  Go back to the FrontPage session and save the index.htm page.
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H.  Developing the Rest of the Pages

69.  Activate the folder list — use the icon or View > Folder List.

8\ |
&
C

70.

Copyright© NESIS 2002 61



website.gxd 4/9/2003 11:53 AM Page 62 $

Website Development & Hosting

71.  Double-click onlinecommunication.htm page to open it. Click the Folder List icon to

ﬂ remove it and have a full-page view.

@ 72.  Create a table of 1 row, 1 column, a border thickness of 1, and a specified width size of 680
pixels.
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73.  With the cursor inside the first table, create a second table with values shown below:

74.  The resulting two tables will be as shown below:
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75.  Split the first row into three columns.

76. Split the last row into two columns.
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77.  Insert the NESIS logo, using Insert > Picture > From File.

78.  In the Images Folder, select the image file nesis_logo.gif.

79.  Click OK. ﬂ :
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80.  Reduce both cell and logo to the proportion shown below (left). Using the same procedure,
insert the ADEA logo (image file adealogo.gif found in the Images folder) on the third
_'-'g cell of the first row, and size both cell and logo appropriately as shown below (right).
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e 81.  With the cursor in the second cell of the first or top row, type the title “Online
! Communication”. Select the title and make the font Verdana, style Heading 2, and
alignment centre.

82.  Change the backgrounds of the rows in the following manner: third and fifth rows red,
" seventh row green and ninth row black.

"yl 83.  Type the following in the third row: Introduction | Netiquette | eLearning | Boards
| Partners | Exercises | Homepage. Select the text and make the font type Verdana,
font size 2 (10 pt), bold and centered.

“E 84.  For each text (except Introduction) create a link to the respective existing web page — as

: per the table below:
Fyi -
Link text Web Page
- g Netiquette netiquette.htm
L3
R eLearning elearning.htm
Boards boards.htm
Partners partners.htm
Exercises exercises.htm
Homepage index.htm
5 :‘
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85. The screen dump below shows the result of the above actions.

|Bim Il e e ek Tl Fym. el ey R
O-F-H& 2 &asy ¢ BT o= HOEE e 5 5.
] & i b ] T ] .r['--|=='! el

EH,UIFW Online Communication ﬁ

86.  Open the downloaded, unzipped and saved document containing the text to be put on the
web created. Scroll to the portion under the title What is Online Communication? copy
the text and paste it in the fourth row, as shown below:

[t B s ok g e e i
Drd-ARE@L: BT o BOER 10 TD.

| [P Fa—— vippe B S QD EEE EE..I!'."-l

ﬂ

A’Ifmp Online Communication %

| wirre . Covillires T unbcst o D6 e F shiy o Drd b O TR e ben

et 15 Onhine Communculisn?

{ e CormTArEC§ DN B U] IPTAR CORTRSTEAten iecheokapen fo nbaract by pasns and
|recEsng sforrunon onbes. Thews comeurscstan ischnoiogen. can sho be wssd (o wupplemand and
|mnkares delsery of sdecsion. Thers s mary fome of corrarscsiion ischroiagea - s ol dan

| wew cutieed badas

-

LI T

L
: L= 0T I:l
' Wemet M . P | 8] I*
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87.  Still on the opened document, scroll down to the section with the title How Is Online
= Communication Different? Copy this title and paste it in the fifth row as shown. Copy
/ the remaining text under this title and paste it in the sixth row.
R, ==

® Vedym lawconierersen
= Torir— g W i e Gibkie g a0m
& Bulistn boands

® eELuda DO
" gegrcheoreaes fonere | theesded dmcucdon].

8 Sprwheirsr Cha (el Do)

1 My shy paaphs brel of sy In sspres thasmashies. ondng. TyTeng of your own Comgul er doa.
ek fpel e g et iloates Thess o leil @oaky then thers reghl b noa e la-lece
SUAFI. Py SIS B BT S meporinl onkng. Thes & proliably g base: of ihs
sz carinon whers one dog e theseng the Intemai o enctfer dog, mayng "On thae Iriemat
repbupily bregrd pouve 4 et

T s On sl fsiegs and OEn adder 10 Sk Gnlce TR o @ N D Nl Sludin . The
G b 10 rRaEd DN Mg G P NH e |

Y. Coriiir penpheng atd gssdeierd o0 Py comeree, Ordew Chal mppess gie Bl of pospls wha |
e klemtifisd ondy by & micinams. On the Irmismst you csn pretend fo b sryans or snything i
Fou want fo b, &0 anelogy megtl bw a culttural or iredironel costume pety. The coabers |

|

Pk e [arEans neal ey Snd Tharg g el nhipraons sedsced !
. 11—, TR —

i ' # 88.  Follow the same procedure for the following two rows (seven and eight), with the result
\wala below:
Fras

Tha kect of fors-cf-vocs womstmen rescls m macommuscaion. Flems san” offen resul

e gn ol posl whoh e nlended Lo b lahen bghEy or Furroroos by BUR was Laken

e pely oF crinically, The Epersl v off sy Naces "= )" 0 connoRe Sharl & 55 S08mens i me i

humcrousiy beipn 8 Wibe, but it may not oe snough 1o prwvent o flame war.

£  The Intemat m tha st sgueirer. & Fagh school viudent can comespond Wi & hicbsl Pros
w0 I s W] O Tral S, deed bl el th pIDdE s e el 07 RarD R0 SR
anlns wi ioes ol the moet promerent clincisra snd e achem in the faid

Wl pse ULy |'r|-:' IR CAanons

Crilirss CONTIRATEC W0 SN [SITrece

® Pyl G SO0 Sy, Wp T

b reiwrecbean af pertspaen b nvoleed

u grh . B e ag (gl va Mt e relond
o preevpe aned pficient Teadbark

& gy al wlamndlen nohdeng sectons M
w 3 sonvey of (TAE OOy (0], we0ng Siudenis, olesonals, e parans e, i

P bask sccomphuhrst I
H.ﬁ
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e o R e e T - T |-._.-|-. [ET .

[Pl Mgt | vmrkernn

M

Ptk 1y af i et dvy o

G an gl Pt g i awoleisd

srhancement, & conplsrents fece o fece scirebas
PRty Gl ol e S T SR

eraring af edormastion nclding ssctronic s

& sirved O Qrous Covwsuraly (@], aeies] §ludin i, proliddadls. Dharr, parns 8025

PR TS ek tharaynd

= ol afvw ey and protleTs solearg
S irerw @il Lulirsiag

spperoortise for enbicsl srd cresires thinking

Sppsrborsleri 16 dviitp s iEen cEsvrureEalEs ihlE

Esck ta top 1

" Wil HTHL J Prrvem 4]

89.  Copy the contents of the last row from onlinecommunication.htm and paste into the last

two cells of the last row, as shown below:

Biach b bop

Mol AT i 7 |4

| =~ [T T | I

90.  Select the phrase Back to top click on the Hyperlink icon and type #top in the URL box,

as shown below. Click OK to close the Create Hyperlink window.
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91.

92.

93.

94.

The link colour changes to blue and underline, as shown below:

& ppportursisn io dessiop emiten comrarashion oy

bl [3 D3k

Wl [ HTRL i 7| 2]

BItscsseeny | [

Creating a Bookmark — allows you to go directly to a heading within a page

Select the title in the green-coloured cell: Why Use Online Communication? Use Insert
> Bookmark.

B T T . ([ = |
[ G e Pk T P e 14

||:u:r-n l-- BRBAT »-n-EOD &0 T 0.

s« B I BEE IEERE .0

=
<

| k] Inrks, bt it Py R Be snnaghi 10 peesser o e wue j
B 1hes praar scuskzer & R Rrhaol CuienT N CoTRCRORO win & P Froe

g factrg on tha nel, and mantal heallh professcneis snd othery csn nterect

ol ey mss i prpssrgnl Clrepiges W NERO e I the R

In the Bookmark dialogue box, type Why Use Online Communication? under the
Bookmark name.

B e et Fma ok Tl P ke b

D-d-Ba0@a. JRMAT -~ SO0 & [0 0.

1w i b e | B SIS EEEE SoA

H

=

hiamoera iy hesiper 3 Brids, haii it My nor e snnagh 10 peessnr B flares e j

5. Thw et i the graae squatew, 4 g vohoc KR
e on an sgus foobrg on e ned, and ments i
il welh Soieg O They S5l el Clepiges %—
Why use Online Communication? n
il-rl.r.l- [ T LR R L —'
| [irly I

B gty of eSEdd Eywians, ybre

& bsrsction of pamicesntt neolesd
1 grhiprcamack, grd complaracks leoa 1o N et

= geraapn awd & enn SEedhack

(= ) o |
& ghang of rformalos nohdng slscteorsc e

Click OK.
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homeroudly beipr a inbs, But i ey nok B5 snough o prevent § flare war
I 3 The Irdsrsi o b prest sgushrer . & agh school et can comesspond with & Ficbsl Prow
¥ wwwaiy e e B EE ] B TP e, e b W P B I e S il el O Falr e e

Bl
orline with. soms of the mart proserent cliecisca snd remachemn in the: fald

Why use Onling Commmuenicalion?

| Cribre coremesrcaton can [ n

95.  Scroll to the top of the page, and select the text Why Use Online Communication? As
shown. Use Insert > Hyperlink.

e G e i Pl [k Teie Ppwes st

O - BRY - | EOQD&B0 T 0.
frwaars 2 a ] _"'""'"'_,___ e [ B O FEEEERE Sh
=

L I

Online Communication

I

96.  In the Create Hyperlink dialogue box, select Why Use Online Communication? as
shown.

ook [ vt = 5 & =fw
[Te |
A CMy DocumentsMy W, Onine Commeancation |
jn-i-nmmlnh Ol Coomrn i adacsn
= _peresle
s
A Fagas
Elwehen_Hiss
[(Jdphereen chass tpshweess clarit
| ] febhoreem class [ e
'_'Il\:hl =i aidciome o the NESIS pitel

= 2 @l 4l = o
wmﬁl N o
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97. The URL portion is automatically updated as shown.

98.  Click OK to create a bookmark at the top of the page, shown by the blue text below.

[ w4 99.  Click the Preview tab to test the effect of the bookmark you have created.

Biri b Online [Hffersm

What is Online Communication?

2l DTETANED S 1EET B UL @Rl COTETures i e hnclogat 1o mberect by paoing snd
FRCEYE) 0 PO Gkl Thedde CoTerorsCalae DECTmobgers © a0 SO B bl B jupshren! e
wnhgrig gelisygry of §0UCsnon, There ge mgny forme. of Gommesme; ghgn ciripoeed - Fome af [
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Click on the bookmark at the top right and notice the effect below — the page jumps to the
appropriate section.

[
D-cb-PRM S8 =l g e A6 0]

e s | YT E IR EERE S

A NS e

Cmling CoOTTTArECAion Cae provids:

Mabdirg of SCCEEE WAt 50yTdeE

e aCion of LTRSS ek

ancEneni, d compleranis. Lsce to face schveme

prargt snd sffcssrs fesdbsch

whisareg =f nformeton rcluding siscirone: S

& mras ol goup commmursty (8.0 aTong tudents, profssmonain, tesren, panslvin wco}

per rewvww g fubaeng
oppriursin for Sofcyl @l craaln ek

 # ® ® ® & & = = @

group lak accompbetbrsent
collazorairss Bumeeg snd problesm =g
opprurelas B deewion wellm ©omeeeec dfeon woil

y ol

Fiswemn /1|

H
DI Eesdra®

Click the Normal tab. Using the same book-marking procedure above, create the second
bookmark, as shown below:

B bl B e Fyma [k T P e e _
L-#-@A0Ga: “BTwm-- EADERDNO0 T 0.
O sovome | WS QI ERS I ES FA -

| Pugen:'mirmcors i e b

is!'im Online Communication

imummwmui Why uss Dnkiie Camimunicalan

i‘ll hat iz Online Communication?

!I.'H'ﬂ! cormmrracalion i wang vieon coreTeeesibon fechrologpes b nilerect By pamang end

| sy rforarion crires. TRastS © DRMFRENEC BRion | RCPraingesd. CBn Ses b sl o popplsreent snsl
mhancy deiresry of sdetabon s o many o of corerursc e e heologees - sore al than
| wrw zinned belas |

u gy
= Telppinores
§ K

=R iy
', Woeml  HTSL B #1411 | --l:|
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Use the preview function to test the bookmark you have created.

Mty thy prop fnd o faky U EeprRiE (e ke Types] 0 piur S Cdmpecla 04t
] Vil ol @ sl bl Thir i ok arely Bhan heire regil B 5 @ Dt 1= Nadi

BladnOn. Fhigpd i WTITRC Do ioBil @ S0 WiF SROMETEA Grbrd Tred o [oolsil The TabE af
Tamcan carfoon whars ans diog i shoreing e Iniemast o sroibee dog, seyeng "0 s Inleees

iy s wouT @ 00"

Ttk 5% nilabbrribagrd oo 0N Edrisr B il ool than 5 8 Tete-16-fecs dfualos, Thi
tan ad 56 ntrsased oslne frbeg = olfererie pliloed rekEtaEpE

Gardsr psviching snd prssdonyme wes fealy commen. Oeline chat reora: sre full of peopls who
e aeniifed onby by @ nickrors . O dhe Inese g can preiead 1o be spone: or anything
Foa wank o Be &n analogy reghf be @ cuibes o radional coobem parly. The coslues
tadas thie pELn s el derbidy gred thay Sed shasr nfbeiiorg meloces

Theip btk of LoraoF-vieli soretrs figulls B e pmrraabon. Flame wad alles et
friwe gn ovierw oot whegh s slarubad 1o ba Lavan bghlly & hpreeouily bul min Laken
sarinaly) o rritically. Tha Sbesrsl s of orisy (508 ™1 )7 06 CoRnois That J STEIBMEn| & misss
Famordutly Pags & SOV, BT o Ay Dol Del i D0 @i & Bies e

Thas Enler=at i thae grean enealicer. & high whool shedient cen commepand with 8 Hobel Frire '

Still on preview page, scroll down to the bottom and click the Back to top link.

O TR D S SRR e de
o CEpOFTIFLCER B deeslap erEree ©oevearer M shille
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ww otliresd) belipees:
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105.  With the cursor at the end of the first bulleted text (i.e. email), and using Insert >
Picture > From File, select the image online.gif.

T S Pl |
106. g ey
lE‘l
Whai 1= Ondine Comimumication?
Conleray © pimERsnes BhOnN §8 WANG) YITTRIE o cE geen. o nbwract by panung and
iy e e (el TPk o oevemprel aTe0n Doiwesiajeic Can S0 D ol D3 Sy e
snhance delreery of siucabon. Thars s marey Tomes of communeca lan fschnolcgaes - usra of Hham
o Dl Bk
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76

107.

108.

Select the inserted image and right-justify it as shown below:

Wit 1= Owline Commumication?

||} Crleren corrarworsc afson m LAnG) VarERI bon {eck Bz r By peanreg mnd
I i B TR (e TR OV nes WO TR RO T MED b e ) peplereenn e
I snbgncw debserg of mducahan Thas e mary fzrres oF comeranscato- bacheclages  sores ol Than

B Twowmiy FSarE lrew felevd s
= Ridieran hoade

& Demcunises bosrda
Al D P | i desisaon]
LE]

Use the Preview tab to see how the inserted page will look in a web browser, with the
image added.

Whai i= Online Commumication?

(=, LR CEAT: T Bz imieract by peannsy snd

rec ey aiEnalen ons, Thna comesares sbon Dechronspes Can 3w b el 0 seppirsen] and
e & dedieery of sducancn fhem s sy fomes of coseviner sron oechankagess - ares af rhes
arm oulbned Deloe

L =]

u Tiglggrtuwea

w IF g pai

L oD

Suie] e ]

Copyright© NESIS 2002



website.qgxd 4/9/2003 11:54 AM Page 77 $

Website Development & Hosting

109. Use the Preview in Browser icon to preview the entire page using your current web
browser.

.F"'
B Ll e bt Fymal [ock Tohie P o i \
D#ﬂ-“‘llﬂlﬁﬂ?l N = e m'l

. P U|== =iz = £rb - |

NSL!'F” Online Communication

Whan 1s CrnBae Commanmni satiomns —_ ‘-'-‘
e GO F10 o R RS COTEe SN LeChnalogert 10 nOEac by pdddeng e ]
recEwTyg niomaben onles. ThEs comrmuscsion lEchnologen can sho be ned o nupplesTen| aed el e
waharce Sebyery o dc#on. |hete @iw many Toems of Commorssabon techrgiogpes - o of e L]
M e badoos =

* Eredd

# Tikiplors

= Fatsmmia

L

m e T D EE TR W]
w Tori—wdy O30 Tl T iyl
= By bods

L s DiEdedf

110.  Scroll down to view the entire page.

How iz Cknline Communication Different? J 2 ﬂ
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robody broren poure @ dog "

1
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wrmp wand I B Bn srakeers reshd be s ndhesl oo brafdenal crsbers sty Tha rosdes |

=] [ |yt
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111.

L= e T e e e e

= Hanbdiy of oo arvwhees, aytrs

m wn b e Pt S e g e S

w DT, P OOy 1S N B0 FCE BE Dl

= prigEpl il alRoed Faedibach

m Ghgie] SF i IgITegieid ol bS] g 17w e

= & fangp OF QieeD COSNARLEY (8 Q) SVEEM) STGIMIE BTN EGONGE, M, RIS B0 )
& FoeD 1k BOCoenlks hsen

w Cilpher g el e g peoblarr- g

o (R Eade W Delonng

opeoriunities for ornesl and cresdee Thinkng

opporiunii s o dersskop s Bn o e phon il

Bk Lo B5h
IR e T T T P F T T T P AT TP P .
[T vl

Use the steps above (which showed how to copy contents to the Online Communication
page) to develop and transfer contents for the remaining pages of your web, as shown by
the following FrontPage and Browser screen dumps.
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netiquette.htm page
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elearning.htm page
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boards.htm page
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partners.htm page (the cells shown here are already in the file
and hence do not need to be created)
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J. Creating an External Hyperlink
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112.  To create an external hyperlink, such as for obtaining an evaluation of the WinZip
programme, shown above by the blue and underlined here, select the text here. Click on
the Hyperlink icon. In the Create Hyperlink dialogue window, type www.winzip.com at
the URL point (which already has http://).
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Iphoreer clasy

m;ﬂﬂ
@ i Wekome ko the NESIS sitel

\o T ,,_.| 113.  Click on the “pencil tab” next to the Target frame. The Target Frame dialogue box below
pops up. Select New Window.

@ 114.  Click OK. Notice that the Target frame has changed from Page Default (none) to New
Window.
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115.  Click OK to obtain the page shown. Notice that the text here is now an external link to
http://www.winzip.com. The “new window” target frame ensures that, using a web browser,
when “here” is clicked, the WinZip website opens in new window (test this to be sure
it works).
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116.  The remaining web pages, as seen using a web browser.
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-J!Ifw Netiquette in Cyberspace
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117.  Close the browser window, the newly created web testweb, and exit FrontPage.

[ ] 118.  To view your web at any time using a web browser, navigate to .../.My Webs/testweb
and double-click on index.htm.
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